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LICENSE AGREEMENT
Preamble

OLYMPUS SOFT IMAGING SOLUTIONS GMBH is manufacturer of the
scan”R software and drivers/interfacing software to Olympus Soft
Imaging Solutions manufactured hardware. These components are
referred to as OSIS scan”"R SOFTWARE PRODUCT.

LICENSE AGREEMENT between END USER and OLYMPUS SOFT
IMAGING SOLUTIONS regarding the OSIS scan”R SOFTWARE
PRODUCT.

IMPORTANT-READ CAREFULLY: Below you will find the contractual
agreements governing the use of the OSIS scan”R SOFTWARE
PRODUCT. These conditions apply to you, the user, and to OLYMPUS
SOFT IMAGING SOLUTIONS. With any of the following actions you
explicitly agree to be bound by the conditions of this contract:
purchasing the software, opening the package, breaking of one of the
seals or using the software.

In case you do not agree with any of the conditions of this contract,
please return all parts of the product including manuals without delay.
Remove all software installations of the product from any computer you
might have installed it on. Return all electronic media of the product or
completely destroy all electronic media of the product and send proof
that this has been accomplished. For a refund, please return everything
to where you purchased the product.

§ 1. Scope

(1) This License agreement explicitly covers only the software diskettes
or other media you received with the purchase and the software stored
on these media, the manuals, as far as they were developed and
produced by OLYMPUS SOFT IMAGING SOLUTIONS.

§ 2. User rights

(1) OLYMPUS SOFT IMAGING SOLUTIONS permits the User, for the
duration of this contract, to use the software on a single computer and a
single terminal on that computer. This license is explicitly non-exclusive,
i.e., the User does not have an exclusive right to use the software. As a
licensed user you can copy the software from one computer to another
by using a computer network or other storage devices, as long as it is
assured, that the software can only be used on a single computer or
terminal at any time and that the conditions set forth under § 4 are
observed.

(2) The User has the right to produce a copy of the software only for
backup purposes.

§ 3. Additional user rights

Only if OLYMPUS SOFT IMAGING SOLUTIONS provides the User with
permission in written form the User can incorporate parts of the software
into other software developed by the User. A distribution of the software
can only be made in compiled form as part of the software developed by
the User under strict observation of the conditions set forth in the written
permission to the User. The User must include the OSIS scan”R
SOFTWARE PRODUCT copyright notification with the User's software.
The User has to make sure, that OLYMPUS SOFT IMAGING
SOLUTIONS cannot be held liable for any damages or injuries resulting
from the use of the User's software, that include parts of the OSIS
scan”R SOFTWARE PRODUCT.

§ 4. Copyright

(1) OLYMPUS SOFT IMAGING SOLUTIONS or its subsidiaries remain
owners of the software and its documentation. With the purchase, the
User obtains ownership of the diskettes or other physical storage
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devices (excluding the software and other data contained thereon), and
the manuals.

(2) OLYMPUS SOFT IMAGING SOLUTIONS reserves the right to all
publications, duplication, editing, and marketing of the software and the
software documentation.

Without prior written permission the User may not:

- change, translate, de-compile or de-assemble the software,

— copy any of the written or printed documentation of the software,
—rent, lease, or license the software to a third party,

(3) The license, property, and user rights to the OLYMPUS SOFT
IMAGING SOLUTIONS software, disks, and manuals may only be sold or
transferred to a third party on a permanent basis, if the third party agrees
to abide by the conditions in this contract.

(4) OLYMPUS SOFT IMAGING SOLUTIONS is the legal owner of all
copyrights and trademarks of the OSIS scan"R SOFTWARE PRODUCT
and documentation. National and international law protect copyrights
and trademarks. OLYMPUS SOFT IMAGING SOLUTIONS reserves all
rights, which are not explicitly expressed in written form.

§ 5. Warranty

(1) OLYMPUS SOFT IMAGING SOLUTIONS guarantees for the period of
12 months after the date of purchase, that the software works in all
major aspects according to the descriptions in the manuals. OLYMPUS
SOFT IMAGING SOLUTIONS, as the producer of the software, provides
this warranty. It does not replace or restrict other warranties or liabilities
provided to the User by local or other sales people or organizations.
OLYMPUS SOFT IMAGING SOLUTIONS does not guarantee that the
software is defect free, that the software fulfills the specific requirements
of the User, or that the OBS scan SOFTWARE PRODUCT works with
other software provided by the User.

(2) OLYMPUS SOFT IMAGING SOLUTIONS further guarantees, that the
software storage devices (floppy disks, CD-ROMs, etc.) and the manuals
are free of material defects. Defective storage devices or manuals will be
replaced free of charge, if they are returned to OLYMPUS SOFT
IMAGING SOLUTIONS within 90 days of purchase and accompanied by
a proof of purchase.

§ 6. Liability

(1) OLYMPUS SOFT IMAGING SOLUTIONS or their sales organizations
cannot be held liable for damages or injuries resulting from the use of the
software or the lack of capabilities of the software, unless the User can
show gross negligence on the part of OLYMPUS SOFT IMAGING
SOLUTIONS. This applies, without exceptions, also to losses of
productivity or profit, interruptions in the flow of business or
manufacture, loss of information, and other financial losses. Without
exceptions the possible liability of OLYMPUS SOFT IMAGING
SOLUTIONS is limited to the amount that the User paid for the product.
These limitations on the liability do not influence claims for reasons of
product liability.

§ 7. Contract duration, legal consequences of violating the license

(1) The contract is deemed to be in force for an unspecified period. The
User rights are automatically terminated if one of the conditions of the
contracts has been violated.

(2) In case of a contract violation the User has to return the original
storage devices and all copies thereof including all modified copies, and
all printed and written documentation to OLYMPUS SOFT IMAGING
SOLUTIONS, or the User has to destroy these items.

(3) In addition OLYMPUS SOFT IMAGING SOLUTIONS reserves the right
to file a lawstuit to claim reparations for damages, non-compliance, or
removal of the software in case of license violations. The following laws
and/or conditions are in effect: the conditions of this contract, copyright
laws, and the laws of the civil code.
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1 Introduction

Thank you very much for purchasing Olympus Soft Imaging Solutions’ High Content Screening System
and for your confidence in our products and service.
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The scan® Acquisition Software controls the hardware components of the Olympus scan”R Screening
Station for Life Sciences. The scan® Acquisition Software is designed for automated image acquisition
of biomedical samples. The acquired images can be optimally analyzed with the scan® Analysis
Software. The software is intended for the use in biomedical research.

A The scan® Analysis Software, the scan® Acquisition Software as well as the hardware
components of the Olympus scan® Screening Station for Life Sciences are for research
use only..

1.1 Abstract

This user manual will guide you through the usage of the Olympus Screening Station and will assist you
in setting up efficient and reliable screens.

The Screening System scan”R is intended to be used for the screening of well-plates and slides. Do
not use the system in other ways than described in this manual.

For detailed information on the separate system hardware components please refer to the
corresponding manuals delivered with the system.

The Screening Station scan”R consists of the following hardware components:

¢ cell*R Imaging Workstation (hardware only)

e [X81 microscope

¢ Microscope stage

e ZDC hardware auto focus device (optional)

e Autoloader robot (optional)

e Laboratory workbench (optional)

Please, keep in mind that all the components are designed to work together as an integrated system.
Taking away or replacing single components without prior consultation of Olympus Soft Imaging
Solutions is strongly discouraged and will most probably impair the performance of the system

dramatically. Any damages to the system due to such mishandling will not be covered by the
guarantee.

All necessary tools for handling and alignment are shipped with the system. To ensure safety and
optimum performance as well as to familiarize yourself with the use of the system we recommend that
you study this manual and the hardware component manuals thoroughly before operating the system.
Keep this manual in an easily accessible place near the Screening System for future reference.

Special care has been taken to guarantee correct and accurate information, although this is subject to
changes due to further development of the Screening System. Thus, the manufacturer cannot assume
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liability for any possible errors. We would appreciate reports of any mistakes as well as suggestions or
criticism.

Please refer to the respective hardware component manuals for regulatory compliances.

1.2 Technical Support

If you find any information missing in this manual or you need additional support, please contact an
Olympus specialist directly.

1.3 Safety Precautions

Before operating the screening system, make sure that you have carefully read and understood all
hardware component manuals and the safety precautions found in the respective manuals.

If the optional laboratory workbench is available, please pay attention to close all doors of the
workbench box before starting a screen. If the screening system is delivered with a robot, always take
care to be well off the robots operational range. For safety precautions during operation or teaching of
the robot please refer to the Hamilton handbook. If a collision of the robot with other equipment occurs,
always switch off the robot controller and manually readjust the robot to the init position before
continuing with any system operation.

Do not use the system in other ways than described in this manual.
Do not move yourself into the operational range of the robot while the system is screening.

Pay attention that no liquid enters the system mechanics and electronics when using well plates with
liquid content.

When changing a sample manually, always retract the objective via the ESC button on the right of your
microscope.

Never change the filters of the MT20 without wearing soft gloves.

3
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2 Short Step-by-Step Guide

This chapter gives a step by step guide on how to use the scan”R software to perform a scan. Detailed
explanations of the entire setup and acquisition procedure can be found in Chapter 3, Main User
Interface.
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Performing a Scan: A Short Step-by-Step Guide

If you use new types of well plates, new types of samples, new staining or staining protocols or if you
alter the optical hardware configuration, you will most probably have to setup new scan settings to
obtain optimal results. In that case this step-by-step guide will be insufficient for your needs. The
necessary information on how to setup new scan settings can be found in the following chapters.

Before the start

Be sure to have switched on all system devices before starting a scan.

Start the scan”R acquisition software

Start the scan”R acquisition software by double-clicking the scan”R Acquisition icon on the desktop.

% Checking hardware components

Checking hardware compaonents, Please wait,

Upon start the software will check the availability and status of all hardware components and inform
you if one of the components is not available. In that case switch on the missing device or configure
the ports (as described in Chapter 6, System Configuration) and execute the command Settings »
Initialize Devices in order to initialize all devices without starting the software anew.

The software will inform you that it is going to calibrate the stage and ask you to confirm. Remove any
obstacles from the stage's operating range and press the Yes button. The stage calibration will take a
few seconds.

vour stage will now be calibrated.
Please make sure that the whaole travel range is freely accessible,

Load or reuse scan settings

Upon starting the software the settings of the previous scan will be loaded automatically. In order to
use settings of earlier scans, use the File » Open Scan command. By default the file selection dialog will
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show the settings directory of the user currently logged onto the system. Navigate to the respective
screen directory and open the file experiment_descriptor.xml.

@ The experiment_descriptor.xm/ of a previous scan will use the filter and objective positions
specified there. If a different hardware configuration is used for the new scan, the settings
might have to be adapted accordingly (see following chapters).

Load the Well Plates

In case of a scan”R system without autoloader robot (or if the robot is not to be used) place the plate
on the stage.

A system with autoloader robot allows screening several well plates within a single run. Up to four
stackers are available on the right of the robot. One of the stackers has to be empty at the start of the
scan and will serve as swap stacker. Note, that there is an additional position in front of stacker 1,
which is used for fine positioning of the plates. Keep this position empty. You can remove the stackers
from their positions to make loading and transportation easier.
When loading the stackers take care of the following:

- Make sure that the transportation covers are removed from the stackers.

- Orientate the plates with the first column pointing towards the microscope.

- Make sure that each stacked plate fits accurately on the plate below.

-  Stack the plates as well aligned as possible.

- Leave a minimum gap of at least 10 mm from the last plate to the top of the stacker to allow

the robot to lift the uppermost plate from the stack.

Autoloader Robot
1 23 4

Microscope
Stackers

Specify and label the wells and the sample

Click the Scan: Edit button (or execute the File » Edit command) to open the Edit Scan window.
Click the Plate Manager tab: the Plate Manager window will open.

Enter a name in the Plate name box. If the plate name remains unchanged in the course of consecutive
scans, the scan directories will be stored with an incremented numeration appended to the name.

Select the well plate format from the Format shortlist.
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& Edit Scan
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Select wells for acquisition by clicking on the circles that represent the wells. Deselect by clicking
again.

Dragging the mouse over a range of circles causes multiple selections. Deselect wells by dragging the
mouse while pressing the Ctrl -key.

Click Edit selection table to get a list of the selected well numbers and their Names or Descriptions.
The names can be changed at will.

Confirm the settings and exit the Edit Scan dialog by clicking OK.

Start the Screen

0 The burner will be ignited automatically after system and software startup. It is
recommended to allow a warm-up time of 10 min to let the light output stabilize before
starting the first screening run.

Start the screen by clicking the Start button on the main window.

The following steps depend on the available hardware.

e |f a ZDC hardware autofocus is available and standard plates with a defined position of well A1 are
used, scan”R will carry out the scan without further user input.
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¢ If no ZDC hardware autofocus is available, scan”R requires the user to set interactively a starting Z-
position for the software autofocus. Afterwards the scan will be carried out automatically.

e |If spotted slides or other sample holders without defined starting positions are used, scan”R
requires the user to move interactively to the center of the first well.

If an autoloader robot is to be used, the scan will be performed on all plates on the stackers 1 and 2.
Afterwards the plates will be returned from stacker 3 to their original positions.

@ The autoloader robot is not able to identify the plate thickness. If you change the well plate
type, you will probably also have to change the robot method. Note that loading well plates
with or without cover also affects the effective stacking thickness of the plates; this has to
be taken care of in the robot settings.

Do not remove the positioning frame in front of stacker 1 from its original position. This
stacker is modified to allow special safety procedures for accurate and robust positioning
and is different from the other stackers.
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3 Main User Interface

This chapter explains the features of the image displays and briefly introduces the different menu
points and buttons accessible from the main user interface.

3.1 Front-Panel DiSPlayS......ueeeuiiiiiiiuriiieesseesiireeeee s s sssereeee s s s sssseeeeessesssnnnens 12
3.2 Display CONEXt MENU .....uueieeiiieciiiiiiieeeeeessirreeeeessesssreeeesseeessnsseeeessesssannen 14
3.3 BULIONS e 16
3.4 Devices — Microscope Control and Live VIEW .......cccuueiieeeiiieiiiieieeee s 17
3.4. 1 MiCrOSCOPE SEHINGS . uuuurrieiiiiiiiirrteeeeseeesirrr e e e s s e ssrrre e e s s s ssssneeeeesseesssnnens 17
I N A e o o1 [ SRR 18
3.4.3 XY NAVIQALION ceeiiiiiieiieeee ettt e e e e e e e e e ner e e e e e s e e nnees 19
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3.1 Front-Panel Displays

T Scan” R Acquisition

Fie View Operabe System About

i
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el e | | s | COE R T —
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The main window features one large and three small live image displays by default. This allows to
separately observe different color channels, a multicolor channel overlay (RGB Overlay + Transmission)
or an online view of the auto-focus procedure (Display AF).

RGE-Overlay o = MOME v Josooo (2910

The drop-down menu below the large image display allows selecting NONE, single channel or a RGB-
Overlay (+ transmission) to be displayed in the main panel.

When RGB-Overlay is selected, the drop-down menus in the colored boxes become available. The
color channels to be displayed in red, green, blue and gray can be selected here. A transmission
channel can be selected in the gray drop-down list.
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The clipping set for the single image channels will be used for the RGB-Overlay. Note however, that the
colors may differ from the single image channels depending on the colors selected there (cf. Chapter
3.2, Display Context Mend).

When RGB-Overlay is selected in the main image, the image status bar lists the zoom-factor, the
intensities in each color channel as 8-bit value and the X/Y pixel-value of the current mouse pointer
position.

When a single color channel is selected in the main image, the image status bar lists the zoom-factor,
the intensity as 12-bit value and the X/Y pixel-value of the current mouse pointer position.

fitc w |1344X1024 0.25% 265 (816,228)
Display AF

Color channels. Select the color channels from the shortlist underneath each display.

o Zoom tool

Zoom. Activate the tool and click on a display to zoom into the image by a factor of 2 centering on the
click position (if possible) while a Shift click will zoom out.

O Hand tool

Hand tool. Clicking this button in case of a zoomed-in display enables you to move the visible area of
the live image via mouse drag.

Image Display Status Bar. The status bar below each display lists the image size, the zoom-factor, and
the intensity minimum and maximum.

I
2

SgisuEgu

r

0 1500 5318
Lounts

Jo)
O

DAPI i 16?2x512 0.5% 283 (542,62)
Display AF

Display AF. Check this box in order to display the images of the autofocus process in the bottom image
display on the right side. If also an image channel is selected in the drop-down menu the display
switches between the autofocus display and the selected image channel. (Note that there may be two
different display settings set for the autofocus and the image display, see Chapter 3.2, Display Context
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Menu.) During the autofocus process the autofocus type, Coarse / Fine AF and the autofocus quality is
shown in red in the upper left of the autofocus image.

System Status Bar. The status bar at the bottom of the main window indicates the progress of the scan
and gives an estimate for the remaining scan time. It gives also the actual well number, the total
number of wells to be scanned, the current position, the total number of positions to be scanned, the
current time-loop and the total number of time-loops to be performed, as well as the current plate
number and the total number of plates to be measured. The MT20-icon indicates if the burner of the
MT20 is switched on or off.

well |2 of 16 Position |1 of 2 Time |1 of 2 Flate |1 of 1 Time remaining: | 00:30 | himin MT20: }: Progress

3.2 Display Context Menu

Palette Gravscale

Display Settings Binary
Gradient
Rairbo
Temperature
Iser Defined

A right-click on a display opens a context menu that allows to select additional display settings and to
configure the multicolor representation.

Palette. Use this command to select the display mode for single channel displays.

Display Settings. Use this command to setup the color display mode. It opens the Display Settings
dialog.

%% Display Settings E
Scaling color: - Click. to choose calor,

Intensity clipping: 1% W

[ oK ] [ Cancel ]

Display Settings: Scaling color. Click on the Scaling color box to open a new window that allows you to
choose a new image display color (Note that this color is not used for the RGB-overlay).

Display Settings: Intensity clipping. To make automatic scaling more effective when noise or bright
impurities are present, you can define how many pixels (as a percentage of the total number of pixels)
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will be displayed uniformly with maximum or minimum brightness. The intensity of the remaining range
of pixels will then be scaled linearly according to the selected color palette. Percentage values can be
set between 0% and 5%. 1% is usually a good value to start with — a slight increase in contrast and
brightness results. If the value is set too high, the dynamic range is reduced visibly and the image may
look oversaturated. Note, that if you use %-clipping, the intensities of different images will be scaled
separately such that you might not be able to visually compare the intensities. In order to get equally
scaled intensities for all images use the histogram clipping.

% Display Settings

Scaling color: - Click ta choose color,

e —
R —

L
1 e o
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Display Settings: Intensity clipping / Histogram
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[ o4 ] [ Zancel ] —
]
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The histogram on the right side of the image displays shows the intensity distribution — in the main
display only in case of single channel displays. If the option Histogram is selected in Intensity clipping,
green horizontal lines that signify the clipping limits can be mouse-dragged to adjust the maximum and
minimum intensity clipping and thus to optimize the image contrast. Note, that the display values are
adjusted for the channels. This means that if you change the channels, the display settings are
changed according to the settings last time the channel was used.
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3.3 Buttons

Scan Buttons. A click on the Start button starts the scan experiment using the current settings. The
Pause and Stop buttons will become active once a scan is started.

Settings Buttons. The Edit and Open buttons lead to the interfaces needed for the setup of system
parameters for a scan experiment.

Open. Allows opening an existing experiment settings file. By default the DefaultSettings.xml file is
loaded at startup. This file is stored in the in the scan”R installation folder in the directory
Mcquisition\Scan Settings Library\current user, where current user corresponds to the Windows login
name. This means that when multiple (Windows-) users start the system, for each user scan”R will load
each user’s default settings.

Scan Settings Online abservation

Fause Edit futofocus | Settings

Skop Devices

Edit. Allows modifying all the settings necessary for setting up a scan like autofocus, acquisition
settings and plate types (see Chapter 4, Sefting up a Scarn).

Devices. Can be used as a preview window and for changing defined color channels. See Chapter 3.4,
Devices — Microscope Control and Live View.

Online observation Buttons. The Images Browse function enables you to browse through the already
acquired images of the current (or a previous) scan. It also allows you to delete entire color channel
sets of images that shall not be considered in the analysis and to generate movies from time loop
scans.

The Autofocus Settings function allows adjusting the autofocus settings during a running scan if
necessary; see Chapter 4.1, Autofocus Settings.
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3.4 Devices — Microscope Control and Live View

The Devices button opens the Device Control dialog that starts live image acquisition and allows to
access a selection of hardware settings directly. The device view can be used as a preview to get an
impression of the sample and to change defined color channels.

2 2w | s ravigatian |
L& ] Exposiae lime (]

Cnarsn

e
[l %mm = camoteres
= ik s

1 5362.94 | [m]

s FEEEER

——1 e

[roep——

| Focus Ocular view Jidtatoze 050427 (1150,2)

3.4.1 Microscope Settings

Camera: Exposure time [ms]. The exposure time determines the period of time during which the CCD
chip is sensitive to incoming light, in other words, during which photons are collected and converted
into charges to be read out afterwards. Enter a value manually or use the Auto set button.

Auto set. Use the auto set button to obtain a value for the exposure time. The exposure time is set such
that the mean intensity of the objects equals a certain value. When the original image was saturated it
may be necessary to press the several times in order to set the exposure time properly. (Note that
when using the Auto set button in order to set the exposure time for different assays, the value set for
the intensity threshold object detection algorithm of the scan”R Analysis software will be the same for
these assays).

Camera: Binning. The CCD chip is composed of many light-sensitive units (pixels). These pixels can be
read out individually (binning = 1x1) or the signal of neighboring pixels can be combined electronically
during data readout (binning > 1x1). Binning reduces the spatial resolution but increases the sensitivity
and thus reduces the exposure time required for a good signal-to-noise ratio. It further reduces the
amount of data and consequently increases the readout speed. Therefore binning is recommended if
weak signals have to be detected at high acquisition rates or if spatial resolution is of minor
importance.

17
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Microscope: Filter cube. Select the filter cube to be used. Note that a filter cube switch is time-
consuming even if the system features the fast IX2_FRFACA filter cube turret. Imaging speed can be
increased considerably by using multi-band filter sets instead of several single-band sets.

Microscope: Objective. Select the objective to be used. Note that a switch of objectives during an
experiment is possible but rather time-consuming. In order to maintain the same focus position for
different objectives use the Objective Parfocality setup (see Chapter 6.3, Objective Parfocality).

Defined Color Channels. Select predefined color channels. The objective, filter cube, illumination
pathway, excitation filter/ contrast inset and intensity of the illumination are set according to the
settings of the predefined color channel. You can change the settings individually. This is indicated by a
“*’ behind the name of the color channel. Click on save to store the new settings.

lllumination: Fluorescence / Transmission. Select one of the two possible illumination modes: epi-
fluorescence illumination with the MT20 or transmission illumination.

lllumination: Excitation filter / Contrast insert. Select a MT20 excitation filter for a Fluorescence image
or a transmission condenser contrast insert for a Transmission image, respectively. It has to match with
the Microscope: Filter cube selection.

lllumination: Light intensity. Use the slider to set the illumination intensity.

Focus. Performs an autofocus procedure (see Chapter 4.1, Aufofocus Sefttings) according to the
current settings.

Ocular view. Enables the eyepiece. As long as the eyepiece is enabled, the image is not updated and
Ocular view enabled is shown in the upper left of the image. Click again to disable the eyepiece.

Image display when ocular view is enabled.

3.4.2 Z Focus

Coarse Fire

Step size
3.00 [prn]
Current position

A 5362.94 | [um]

Z focus: Slider. Use the slider for larger movements of the microscope Z-drive.
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Z focus: Coarse buttons. Click on the arrows on the left to move the Z-drive in steps 10 times as large
as set in Step size.

Z focus: Fine buttons. Click on the arrows on the right to move the Z-drive in steps as set in Step size.
Z focus: Z-drive steps [um]. Set here the step size for the z-drive when using the z-drive buttons.

Z focus: Update. Click here to update the Current position after moving the Z-drive manually at the
microscope.

3.4.3 XY Navigation

Zfocus  AY navigation I

Row
B ¥
Calumn

4 v

Row, Column. Use these boxes to move the stage to the well of interest. Make sure that the correct
well plate type is selected and that the stage is calibrated. See Chapter 6.2, Stage Calibration.

Navigation: Interactive Scheme. The blue circle represents the well currently placed under the
objective. The white rectangle represents the field of view of the camera. Click anywhere in the scheme
and stage will move this spot to the center of the field of view. When XYZ Limits (cf. Chapter 7.3.2,
LimitSetup.exe) is activated, white lines represent the limits of navigation for X and Y.

3.5 Menus

File » Open. This command loads scan settings from experiment_descriptor.xml/ files. It can also be
executed with the Open button.

File » Save as. This command saves the current scan settings to an experiment_descriptor.xml file.
Note that this is performed automatically upon starting the scan.

File » Edit. This command allows to edit the current scan settings and to define new types of formats
(see Chapter 4, Setting up a Scan). It can also be executed with the Edit button.

File » Exit: This command shuts down the scan AR software.
View » Status Bar: This command minimizes the scan”R window to display only the Status Bar.

View » Main Window: This command minimizes the scan”R window to display only the largest of the
four displays.

View » Maximized: This command causes the entire scan R window to be shown.
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View » Log File. This command opens the log file. The log file contains all executed steps of the scanR
system. Deactivate the Go to the end of text checkbox in order to navigate through the log file.

45.516: Well=1, Pos =6 v
Z move bo 528720

Z move bo 525500

Z move o 528580

Z move bo 525960

Z move to 529040

Z move ko 529120

Z move o 529200

Z move o 529280

Z move o 529360

Z move to 529440

Z move o 529520

Z move o 529600

Z move o 529680

Z move ko 529760

Z move to 529540

Z move o 529280
57.031: End of acquisition

58.312: Screen stopped by user,

Go ko end of text

Operate » Device Control. This command starts live image acquisition and opens the Device Control
window that allows to access a selection of hardware settings directly. It can also be executed with the
Devices button.

Operate » Start Batch. This command opens the Batch Selection window to create a list of experiment
descriptor .xml files and then start a series of scans with different settings.

¥ Batch Selection &l

Bakch Lisk

D:hexperiment_descripkar . xml ~

Operate » Start. This command starts a scan. It can also be executed with the Start button.

System » Initialize Devices. This command performs a hardware component check. It is necessary, for
example, if a device is switched on after the software has been started.

System » System Configuration. This command opens the window that allows configuring the hardware
modules. (See Chapter 6,System Configuration).

System » Stage Calibration. This command starts the stage calibration (See Chapter 6.3, Stage
Calibration)

System » Import Plate Types. This command allows importing new plate type definitions that are not
available in the plate type list.

System » Objective Parfocality. This command allows you to set an offset for the Z-position for the
used objectives, so that when changing the objective, the focus is maintained. Therefore enter a value
for Parfocality [um] to correct the focus shift for the objectives relative to the objective which you used
for the autofocus (cf. Chapter 6.3, Objective Parfocality)

About. This command gives system and software information.
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4 Setting up a Scan

This chapter gives a detailed description on how to customize scan settings and how to setup the
system for maximum performance and reliability. The necessary settings encompass the selection of
appropriate microscope, illumination and camera settings, the Autofocus setup, the parameterization of
the well plates and the details of the imaging to be performed at each position.
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The scan”R Screening Station is a complex system with a number of hardware devices and a wide
range of experimental possibilities. In order to perform a scanning experiment a complete set of
parameters is required with information that allows the controller to synchronize the motorized
microscope modules, the illumination source and the motorized stage with the camera, that configures
the autofocusing procedure and, last not least, defines the type of imaging experiment to be executed
at a precise pattern of positions on the plates and within the wells.

The Edit Scan dialog window allows you to modify and verify all settings. To open it, click the Edit
button or select File » Edit.

Aukofocus Acquisition | Plate Manager

All modifications in the settings persist until they are changed again. When starting a scan, the
complete settings will be stored in the resulting directory in a file named experiment_descriptor.xml.
Note that by default the current user settings will be stored in DefaultSettings.xm/in the in the scan”R
installation folder in the directory .\Acquisition\Scan Settings Library\current user, where current user
corresponds to the Windows login name. This means that when multiple (Windows-) users start the
system, for each user scan”R will load each user’s default settings. Another filename or folder to store
the user settings can be set via File » Save as. It is also possible to reload a saved set of settings via
File » Open and load an experiment_descriptor.xml file or a click on the Open button and change the
settings at will.

The Edit Scan dialog window groups the settings on three tabs:

e Autofocus to define and optimize the autofocus procedure

¢ Acquisition to define and visually control the microscope, camera and illumination settings, to set
cycle times for scan repetitions and to setup the acquisition of z-stacks

¢ Plate Manager to choose the well plate format, select the wells and the positions within wells to be
imaged.

4.1 Autofocus Settings

Test Current system settings. Click here to open the Autofocus Settings window. It allows you to
crudely focus and to control if the autofocus channel settings lead to images suitable for autofocusing.

@ When opening the Autofocus settings window, the Autofocus tab remains active. Move the
Autofocus settings windows aside to access the Autofocus tab and change the settings
(e.g. exposure time, etc.).

Type. Select the method to quantify the image focus from the following options:
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e Gradient. The focus is determined by analyzing mean intensities and intensity gradients of image
structures.

¢ Object-based. The software first detects the objects in each image and then determines the focus
by analyzing their mean intensities and intensity gradients. The result is weighted with the number of
detected objects. The objects have to be defined via Object-based: Test current system settings,
see Chapter 4.1.5, Object-based Autofocus. Note that Image acquisition is skipped if no objects are
detected to save disk space.

¢ Object-based: coarse on A1. This is the same method as above with the difference that only on the
first position of the first well both a coarse and a fine autofocus scan are carried out. On all other
positions only the fine autofocus is performed. This leads to an increased imaging speed, however is
only suitable for plane samples.

& Edit Scan
Autofocus Acquisition | Plate Manager
Tesk 2 syt LEi 6
il et [[] Interpolate AF start positions Calculated depth of Field | 2812 | nm
Type e
radient v | Collect | reference positions Set | as step width
Repeat autofocus in each time-lapse cycle
Coarse aukofocus Fine autofocus
|8 = | Lavers |10 % | Layers
Camera
~ x| )
Exposure time [ms] Binring |11.25 1% step width [um] |2:81 5| step width [um]
|2a | :auto set | ;2x2 v
Microscope Sean range [um] Scan range: [Jm]
Cbjective ~ Filker cube ) 100 M5 30~ 15
|UPLSAPO 10x  » DAFifTR ~ a0- 25—
et 20-
Tlurninakion 5 15-
402 z
Fluorescence 205 10 g
[ Transmission : St
Excitation filter - DE Current position — 0- Coarse Focus position
|papr 350/50 v 201 5=
Ermission filer 40- -10-
Filker 1 = il
&0= p
. ) b -20-
Inkensity 1100 1% 80— -25-
:J = B N TS
100 Fae
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e Object-based coarse, gradient fine. This method combines the other methods to determine the
focus. It requires a ZDC hardware autofocus device. The object-based focus quantification is used
for the coarse autofocus, while the gradient-based quantification is used for the fine autofocus.

0 For ease of use it is recommended to select the Gradient mode.

Repeat autofocus in each time-lapse cycle. If the option is NOT active, autofocus scans are carried out
in the first cycle only. The focal positions found in the first cycle are then used for the image acquisition
in the following cycles. If Repeat autofocus in each time-lapse cycle is activated, autofocus scans will
be repeated in each time-lapse cycle. This reduces the overall speed of the experiment considerably
but may be necessary if focus drifts are to be expected.
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Camera, Microscope and lllumination settings. See Chapter 3.4, Devices — Microscope Control and
Live View)

Exposure time: auto set. Use the auto set button to obtain a value for the exposure time. The auto set
button is available only when the Autofocus settings window is opened via the Test button. The
exposure time is set such that the mean intensity of the objects equals a certain predefined value. Note
that this value is much less than the value specified for the image acquisition channels (see Chapter
3.4.1, Microscope Settings and Chapter 4.2, Acquisition Settings) to reduce the time necessary for the
autofocus procedure. When the original image was saturated it may be necessary to press the several
times in order to set the exposure time properly.

411 Coarse Autofocus

The following settings are interdependent and the software will adjust the controls using the equation
Scan range = Layers x Step width.

Scan range. Use one of the sliders or type in a value to set the imaging range for the coarse autofocus.
Make sure that the range is large enough to encompass all possible variations of focal positions caused
by the unevenness of the substrates.

@ If the scan range is set too large, it may be possible that the autofocus focuses on the
wrong surface, for example on dust particles underneath the plate.

Step width [um]. The step width between neighboring Z-positions is set automatically to four times the
Calculated depth of field (see next Chapter 4.1.2, Fine Autofocus). However, it can be changed at will
here.

Layers. This is the number of layers to be imaged during the coarse autofocus scan. It is automatically
calculated from Step width and Scan range.

Interpolate AF start positions. See Chapter 4.1.4, Autofocus with Interpolated Starting Positions.
Step-by-step. In order to avoid having to run a coarse autofocus scan at each well, it is possible
to interpolate a plane of focal positions over the entire well plate. The corresponding Z-value at
each well will then be used to start the fine autofocus scan. The plane is fitted to the values found
using the Collect reference positions button.

Collect reference positions. See Chapter 4.1.4. Reference positions for the plate can be collected
in order to either interpolate AF starting positions for all wells, or to measure maximum and
minimum focus position for selected positions, in order to determine a value for the coarse
autofocus range.
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4.1.2 Fine Autofocus

Calculated depth of field. This is the theoretical depth of field as determined by the NA of the selected
objective. It does not make sense to set the step width significantly smaller than this value.

A rather crude approximation is used for the calculation (450/NA2 nm). This approximation is
theoretically reasonable only for low NA values and a wavelength of 500 nm. However, it leads to useful
step width values for objectives with high NA as well.

Set as step width. Click here to set the Calculated depth of field as step width between neighboring Z-
positions of the fine autofocus scan. The number of Layers will be adjusted automatically.

@ This function additionally sets the step width of the Coarse autofocus to four times the
Calculated depth of field and adjusts the number of Layers accordingly.

The following settings are interdependent and the software will adjust the controls using the equation
Scan range = Layers x Step width.

Scan range. Use one of the sliders or type in a number to set the imaging range for the fine autofocus.
Reasonable values to start are +10 pm and -10 pm.

Step width [um]. You may set here a value different from the Calculated depth of field as step width to
be made between neighboring Z-positions during the fine autofocus scan.

Layers. This is the number of layers to be imaged during the fine autofocus scan. It is automatically
calculated from Scan range and Step width.

4.1.3 Gradient Autofocus Adjustment: Step-by-step

The Gradient Autofocus algorithm determines the focus by analyzing mean intensities and intensity
gradients of image structures.

1. Select the Gradient autofocus procedure.

2. Select suitable Camera, Microscope and lllumination settings.

3. Click the Fine autofocus: Set button to automatically set the Fine autofocus: Layer Step
width.

4. Set the Fine autofocus: Scan range to +/-10 ym.

5. Set the Coarse autofocus: Step size to 10 ym. It should not be larger than half the Fine
autofocus: Scan range.

6. Set the Coarse autofocus: Scan range to +/-50 pm, for example.
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7.

OLYMPUS

Once finished, click the Test button.

8.

The Autofocus settings live image window will open and display a live image acquired with
the settings of the Autofocus tab...

Focus manually using the Z-focus wheel on the microscope or use the Z-focus tools (see
Chapter 3.4.2, Z-Focus) in the software to focus the sample roughly. (You can use Ocular
View to switch the microscope from camera view to ocular view). When using the z-focus
wheel on the microscope to set the focus do not forget to press Update to set this position in
the software.

%% Autofocus sattings
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10.

In order to change the illumination or microscope settings, you can move the Autofocus
settings window aside to have access to the Edit scan » Autofocus tab. The changes made
in the Autofocus tab will immediately be applied.

11.

Click Focus to run the autofocus. First the coarse AF is performed and afterwards the fine
AF. Afterwards the focused image is displayed in the main panel and on the graph on the
right the quality of the AF procedure is displayed. The focusing was successful when both
curves (for fine and coarse AF) show a pronounced peak.

12.

To optimize coarse and fine range change the corresponding settings in the Autofocus tab
and click again Focus in the Autofocus settings window to run the AF procedure. (You can
also navigate to other positions on the plate using the XY navigation tool, (see Chapter 3.4.3,
XY Navigation))

13.

When you are satisfied with the result close the Autofocus settings window by clicking OK.
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4.1.4 Autofocus with Interpolated Starting Positions: Step-by-step

This procedure may be helpful if no ZDC hardware autofocus is available. If the focus positions at
different stage positions differ strongly, it is likely that the software autofocus will not be successful
unless information about a suitable starting position is available. Therefore it is possible to detect focus
positions at different stage positions first and then to interpolate these positions to obtain a plane of
starting positions for the coarse / fine autofocus.

Interpolate AF start positions. Activate this option on the Edit Scan » Autofocus tab to enable the
interpolation.

Collect reference positions. This button opens the Reference Focus Positions window where up to
40 reference positions can be set.

i’ erence Focus Positions

A set of reference Focus positions allows ta interpolate the starting position For the software autofacus.
1. Move to an arbitrary stage position, 4, Repeat these steps several times,

2. Focus the specimen. 5. Click. OF ka confirm,

3. Click Add to set the reference position.
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Clipping
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to reference list
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& oK Cancel

1. Click the Collect reference positions button to open the Reference Focus Positions live
image window.

2. Focus manually using the Z-focus wheel on the microscope or use the Z-focus tools (see
Chapter 3.4.2, Z-Focus) in the software to focus the sample. (You can use Ocular View to
switch the microscope from camera view to ocular view). When using the Z-focus wheel on
the microscope to set the focus do not forget to press Update to set this position in the
software.

3. Click the Add button to add the first position

4. Move the stage with the joystick or by using the XY navigation tool. (See Chapter 3.4.3, XY
Navigatior)...
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5. Repeat the Z-focus measurement at two or more different stage positions that are
reasonably far apart.

6. From these measurements scan”R will interpolate a grid of starting positions.

7. At each measurement position the software autofocus takes the interpolated Z-value as start
value for the coarse autofocus and performs coarse and fine autofocus according to the
ranges set in the Edit Scan » Autofocus tab.

8. The values given as Z_min, Z_max, Z_range can also be used to adapt the range of the
coarse Autofocus. This way the range of the coarse autofocus can be set to match the
difference between the maximum and the minimum value of the reference positions.(In order
to minimize the possibility of wells to be outside of the scan range, an extra margin to the
scan range of the coarse autofocus can be added.)

4.1.5 Object-based Autofocus

The Object-based Autofocus algorithm first detects the objects in each image and then determines
the focus by analyzing their mean intensities and intensity gradients.

The weighting function of the coarse autofocus is calculated from the sum of all objects' sharpness
functions and is very sensitive to the number of objects detected. The Object-based Autofocus
properties must be adjusted carefully to ensure that the number of objects is maximal when the image
is focused.

The Object based autofocus may be suitable if a certain structure placed in a certain Z-layer within the
sample is to be focused (e.g. small cells growing upon larger cells). By setting min / max cell size
accordingly, it can be ensured that the desired objects are used for autofocus.

o Note that the Object-based Autofocus properties are important also because images void
of detected objects will not be stored on hard disk during the scan.

Click the Test button on the Edit Scan » Autofocus tab to open the Autofocus Settings window. The
functions needed to adjust the object recognition are shown in the Autofocus Settings window.

Threshold. The threshold causes all image areas — better said all image pixels — of lower intensity to be
ignored for object detection. This prevents that background noise or low-intensity artifacts are falsely
detected as objects. The value should be somewhat higher than the background intensity but lower
than that of any cell or structure of interest.

Minimum cell size. Activate this option if you want to set a minimal size for detected objects. Enter the
minimal number of pixels in the box below.

Maximum cell size. Activate this option if you want to set a maximal size for detected objects. Enter the
maximal number of pixels in the box below.
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It is possible to use regions of interest (ROIs) to set the maximum and minimum size. To do so, click
the ROI button (rectangle icon next to the bottom right corner of the live image) and draw a (green)
rectangle to define the respective ROI. Click Set current ROI to adopt the values of the ROI.

Minimum cell size: Set current ROI. Click here if you have defined a ROI that determines the minimal
size of the objects.

Maximum cell size: Set current ROI. Click here if you have defined a ROI that determines the maximal
size of the objects.

Mark center. Activate this option in order to mark the center of each detected object with a red dot.
Frame object. Activate this option in order to mark each detected object with a red bounding frame.
Ignore border objects. Activate this option in order to have objects touching the image borders ignored.

1. Select the Object-based autofocus procedure.

2. Select suitable Camera, Microscope and lllumination settings.

3. Click the Test button on the Edit Scan » Autofocus tab to open the Autofocus Settings
window

4. Focus manually using the Z-focus wheel on the microscope or use the Z-focus tools (see
Chapter 3.4.2, Z-Focus) in the software to focus the sample. (You can use Ocular View to
switch the microscope from camera view to ocular view). When using the Z-focus wheel on
the microscope to set the focus do not forget to press Update to set this position in the
software.
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5. Set a value for Threshold. To determine a meaningful value, activate the pointer tool by
clicking the arrow button in the tool bar at the bottom right side of the image window. Move
the cursor over a background area towards the border of an object. The image information
bar below the image window list the intensity at that point. For an initial try you may set the
threshold to such a borderline value.

6. Activate Minimum cell size and click the ROl and draw a rectangle which is somewhat
smaller than the smallest object to be detected.

7. Click the Set current ROl below Minimum cell size. The value is entered in the corresponding
pixel field. Alternatively you can directly enter a value in the pixel field.

8. Activate Maximum cell size and click the ROl and draw a rectangle which is somewhat larger
than the largest object to be detected.

9. Click Set current ROl below Maximum cell size. The value is entered in the corresponding
pixel field. Alternatively you can directly enter a value in the pixel field.

10. Check Mark center and Frame object.

11. Click Focus to run the autofocus. First the coarse AF is performed and afterwards the fine
AF. Afterwards the focused image is displayed in the main panel and on the graph on the
right the quality of the AF procedure is displayed.

12. The detected objects are numbered and indicated by a red box.

4.2 Acquisition Settings

Selected Color Channels list. This lists all currently defined color channels in the order of acquisition.
Select a channel by mouse click for modification. Drag a channel up or down to alter the channel
acquisition order.

New. Click here to add a new color channel to the list. The new channel will be given the name Blank
by default and can be changed in the Name box. It will be used for the image file name upon storage.

Remove. Removes a channel from the selected color channels. The channel will be stored in the
Defined Color Channels list.

Defined Color Channels List of predefined color channels. The predefined color channels can be
changed in the Device window (Settings » Devices).

Add to list. Adds a selected color channel from the Defined Color Channels to the Selected Color
Channels. The color channel will be added at the bottom of the list.

Delete. Click here to delete the listed Image type from the Defined Color Channels list.
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Live settings. Click here to start a live image acquisition in a new window that opens. This allows
observing the influence of the settings changes online. See Chapter 4.3, Live Settings. Note that first an
autofocus scan will be carried out. When no ZDC is available the sample, a starting position has to be
selected for the autofocus procedure. After that an autofocus is performed and the Live settings control
window opens.

%% Edit Scan
Autoforus | Acguisition | plake Manager
Selected Calor Channels - -
. Live setkings
A
fite |
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lo Ell |1 = lomomon & |
Storage directory | D:iTest I=3)

Microscope: Objective. Select the objective to be used. Note that a switch of objectives during an
experiment is possible but rather time consuming. . In order to maintain the same focus position for
different objectives use the Objective Parfocality setup (see Chapter 6.3, Objective Parfocality).

Microscope: Filter cube. Select the filter cube to be used. Note that a filter cube switch is time
consuming even if the system features the fast IX2_FRFACA motorized filter cube turret. Imaging speed
can be increased considerably by using multi-band filter sets.

Microscope: Z offset [um]. This allows setting a Z-position offset for the image acquisition relative to
the position found by the autofocus. The offset is useful for imaging structures that are located in a
different Z-position within the sample than the position found by the autofocus. The Z-offset is most
conveniently set interactively in the Live Settings window (see Chapter 4.3, Live Settings).

Camera; Exposure time [ms]. The exposure time determines the period of time during which the CCD
chip is sensitive to incoming light, in other words, during which photons are collected and converted
into charges to be read out afterwards. Enter a value manually or use the Auto set button.

Auto set. Use the auto set button to obtain a value for the exposure time. The auto set button is
available only when the Live settings control window is opened via the Live Settings button. The
exposure time is set such that the mean intensity of the objects equals a certain value. When the
original image was saturated it may be necessary to press the several times in order to set the
exposure time properly. (Note that when using the Auto set button in order to set the exposure time for
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different assays, the value set for the intensity threshold object detection algorithm of the scan”R
Analysis software will be the same for these assays).

Camera: Preacquisition delay [ms]. You may set a delay to be applied before the color channel is
acquired. Enter a preacquisition delay, e.g. if transmission light intensity is to be changed during
acquisition to wait for the light intensity to reach a constant value.

lllumination: Fluorescence / Transmission. Select one of the two possible illumination modes: epi-
fluorescence illumination with the MT20 or transmission illumination.

lllumination: Excitation filter / Contrast insert. Select a MT20 excitation filter for a Fluorescence image
or a transmission condenser contrast insert for a Transmission image, respectively. It has to match with
the Microscope: Filter cube selection.

lllumination: Light intensity. Use the slider to set the illumination intensity of the MT20 and the
transmission light, respectively.

Z-stack settings: Layers. Set the number of layers of the Z-stack.

Z-stack settings: Step width [um)]. Set the distance between the layers of the Z-stack.

Z-stack settings: Projections. If this option is checked a Z-stack will be acquired but not saved as such.
The software calculates a maximum intensity projection (*fitc_zMax.tif), a maximum-minus-mean
intensity projection from Z-stack (*fitc_zMaxBkg.tif)f and a /ayer-of-origin image of the maximum
intensity projection (*fitc_zMaxZ.tif) and only keeps the central layer (i.e. the layer found by the AF
procedure) of the original stack (*fitc.tif). All four images are then being stored as a four-channel image.
(Recommended to use with high Numerical Aperture (NA) objectives; use *_zMaxBKG.tif for object
segmentation in the Analysis).

fitc.tif fitc_zMax.tif

fitc_zMaxBKkg.tif
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Time-lapse settings: Loop. Select the kind of time-lapse experiment: for the whole plate, for a well or
on each single position of a well.

Time-lapse settings: Cycles. Set the number of times the entire plate scan is to be repeated.

Time-lapse settings: Cycle time. Set the repetition time. If this time is smaller than the time required for
a single run, the repetition will be performed as fast as possible without delay.

Image acquisition: Binning. The CCD chip is composed of many light-sensitive units (pixels). These
pixels can be read out individually (binning = 1x1) or the signal of neighboring pixels can be combined
electronically during data readout (binning > 1x1). Binning reduces the spatial resolution but increases
the sensitivity and thus reduces the exposure time required for a good signal-to-noise ratio. It further
reduces the amount of data and consequently increases the readout speed. Therefore binning is
recommended if weak signals have to be detected at high acquisition rates and if spatial resolution is
of minor importance.

Storage Directory. Set here the general scan data directory. The data for each individual plate will be
stored here in a subdirectory with the same name as the plate.

4.3 Live Settings

Click the Live settings button in the Edit Scan » Acquisition tab to come to the Live settings window
that allows you to observe the changes of the settings on the image acquired by the camera.

1. If a ZDC hardware autofocus is available the system will first perform a complete hardware
and software autofocus run as defined in the Edit Scan » Autofocus tab; see Chapter 4.1,
The Autofocus Settings. When the AF procedure is completed, the Live settings window
opens.

2. If no ZDC is available the starting position for the software Autofocus has to be set first. In
this case the Manual Focus window opens. The settings of the Autofocus tab are used for
this display (i.e. the color channel used for Autofocus is shown).

The

e autoforus requines & starting posiion.
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Focus manually using the Z-focus wheel on the microscope or use the Z-focus tools (see
Chapter 3.4.2, Z-Focus) in the software to focus the sample. (You can use Ocular View to
switch the microscope from camera view to ocular view). When using the Z-focus wheel on
the microscope to set the focus do not forget to press Update to set this position in the
software.

Click OK to start the software autofocus.

Once the autofocus run is completed the Live Settings window will appear in addition to the
Edit Scan window. The color channel selected in the Selected Color Channels list of the
Acquisition tab is shown. The quality of the autofocus is shown as a graph.

In order to change the color channel, the illumination or microscope settings, you can move
the Autofocus settings window aside to have access to the Edit scan » Acquisition tab. The
changes made in the Acquisition tab will immediately be applied.

@ When opening the Live settings control window the Acquisition tab remains active. Move
the Acquisition settings windows aside to get access to the Acquisition tab and to change
the settings (e.g. color channels, exposure time, etc.).

You can now change and check the settings in the Edit scan » Acquisition tab and have control over
these settings in the Live settings control window simultaneously. The status bar below the live image
display gives information about the image size, the display zoom factor, the image type as well as the
intensity and the coordinates of the cursor. Check the exposure time for all Color channels and avoid
over-saturating the camera by keeping the maximum intensity well below 4095 counts (the maximum of
a 12-bit camera). Adjust the Camera: Exposure time on the Edit Scan » Acquisition tab accordingly.

ve settings control
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o The camera has a bit depth of 12 so that saturation is reached at pixel values of 4095.
However, the pictures are stored with 16 bit depth for reasons of computer efficiency.
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Z-offset (relative to the AF position). Use the arrow buttons to determine the focus offset of the different
channels relative to the position found by the autofocus. The offset is useful for imaging structures that
are located in a different Z-position within the sample than the position found by the autofocus. The Z-
offset set in the Live settings control window is also entered in the Z-offset field of the Edit Scan »
Acquisition tab. Color channels are switched by selection on the Edit Scan » Acquisition tab. (Note
that in the Live settings control window you can only change the Z-offset, but not the Autofocus
properties.)

Autofocus quality: Coarse and Fine. These two graphs enable you to judge the performance of the
software autofocus. If either graph shows a pronounced peak, the focus has been found and the
settings in the Edit Scan » Autofocus tab are suitable. If the maximum of one or both curves is located
at the left or right border of the scan range, the settings have to be adjusted.

@ If the Autofocus quality functions do not show a pronounced peak, the focus has likely not
been found. Enlarge the Coarse autofocus: Scan range in the Edit Scan » Autofocus tab or
try to find a more reasonable starting position.

4.4 Plate Manager

The Edit Scan » Plate Manager tab provides the functions needed to define the pattern of wells and the
pattern of positions within each well to be imaged during the scan.

441 Well pattern

The circles (or squares) in the scheme represent the wells of the selected well plate type. Blue circles
are wells activated for scanning, gray circles are wells to be skipped.

Plate. Enter a name in the box. If the plate name is unchanged in the course of consecutive scans, the
scan directories will be stored with an incremented numeration appended to the given name.

Type. Select the well plate format from the shortlist of standard plate types. It is possible to add
custom plate types via Edit plate types and the Plate Type Settings window; see Chapter 4.5, Plate
Type Settings.

Edit selection table. This opens the Well Description window with the list of selected wells. You can
enter a name or description for the selected wells. It is also possible to Import a well selection.
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% Edit Scan

OLYMPUS
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Selecting wells. No wells are selected by default. Click on a well to select it. Click again to deselect it.
To select a group of wells, drag a rectangle around the wells. To deselect a group of wells, press the
Ctrl key and drag a rectangle around the wells.

Meander Wells. Click here if the wells are to be scanned in meandering order rather than in numeric
order (row by row from left to right).

4.4.2 Positions in well

scan”R is able to scan a series of positions within each well. The pattern of positions to be scanned is
defined in the Positions in well box on the right side of the Plate Manager. To specify the pattern to be
scanned within each well, use the Positions, Spacing and Selection fields. The pattern is based on a
basic rectangular pattern and can then be refined by manual selection of a sub-set of positions.

The number of Columns and Rows as well as their distances can directly be entered in the
corresponding fields. Alternatively a special Pattern can be selected from the shortlist. By default the
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spacing between adjacent positions is set so that neither an image overlap nor a gap results. It is
calculated from objective magnification and camera chip size.

Pattern. Set the number of Columns or Rows that are to be scanned within one well. The shortlist
contains also special patterns like single, 2*2, full in and full out.

Pasitions in well

eo0C*o

Del key removes

selected positions [Invert ] ’ Resch ] LAl

Full in Pattern

Spacing: Column spacing [um]. Set here the distance between (the centers) of two adjacent Columns
of positions.

Spacing: Row spacing [um]. Set here the distance between (the centers) of two adjacent Rows of
positions.

Spacing: Tile. Click here to reset the spacing between columns and rows to the default (without gaps or
image overlap).

Spacing: Field of view. This is the specimen area covered by a single image. It depends on objective
magnification and camera chip size.

Spacing: Total positions. Shows the number of positions per well.

Positions in well

el ml el dre

Del key removes
selected positions

[Invert l [ Reset ] [ Fill l

Full in pattern with removed central positions.

The scheme shows the basic rectangular positions pattern relative to the entire well (the green circle).
By default all positions will be scanned. To modify this pattern use the tool buttons on the left to select
a sub-set of positions. Remove the selected positions from the well pattern by pressing the Del key.

Selection: Invert. Click here to invert the pattern of selected positions.

Selection: Reset position defaults. Click here to return to the basic positions pattern (as defined by
Columns/Well and Rows/Well) and the default autofocus settings for each position (see the Selection
context menu).
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Selection: Fill. Click here to fill a ROI (e.g. a drawn circle or rectangle) with sub-positions.

Selection context menu. A right-click on a position opens its context menu. This context menu allows
selecting the kind of autofocus to be carried out at every position individually. Depending on the
sample it may or may not be useful to carry out the hardware autofocus and/or the coarse software
autofocus only at the first position and only the fine software autofocus at each position.

v AF Fine

v AF Coarse
v AF Hardware

Acquisition: Meander. Click here if the positions are to be scanned in meandering order rather than in
numeric order (row by row from left to right).

Acquisition: Center Start. For scan patterns full in and full out the central position is selected as starting
position.

Acquisition: Show order. Click here to display an animation of the optimized position acquisition order.
Click again to stop the animation.

4.5 Plate Type Settings
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Click Edit plate types in the Edit Scan » Plate Manager tab to open the Plate Type Settings window.
Here new plates can be created and existing plates can be changed (Geometry of the plate and A1
position). As the settings for the ZDC are depending on the plate type used, the ZDC related settings
can also be found here (Well bottom box). When an autoloader robot is used to place the plates onto
the microscope the robot method can be selected in this window as well (Autoloader box). The
Autoloader parameters define the automation method for an autoloader robot. The functions are active
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only if the robot is activated in the Devices and Ports tab of the System Configuration; see Chapter
6.1.1, Devices and Ports.

On the left side of the window the currently available plates are listed. New plate type definitions that
are not available in the plate type list can be imported with System » Import Plate Types.

The light blue marked plates are calibrated plates. The settings of the calibrated plates can not be
changed. The message “System calibrated format, Press “new” to modify the format” is shown right to
the plate type. The settings for light green and white plates can be changed. For light green plates the
A1 position has already been calibrated (see Chapter 4.5.1, Well Measuremeni), whereas for plates that
are not calibrated (white) the A1 position has to be set when the scan is started.

Delete. Click here to remove the selected custom plate type from the shortlist. Standard plate types
cannot be removed.

New. Creates a new plate type.

Type: Enter here the name of the well plate type as it is to be listed in the shortlist.

Plate geometry settings

Columns, Rows. Set here the number of columns and rows of wells on the plate, respectively.

Column, Row: Spacing [um]. Set here the distance between the centers of two adjacent well columns
and rows, respectively.

Well geometry. Enter here the shape (circle or rectangle) and the diameter of the wells.
A1 settings

A1 position: 3-point A1 measurement. See Chapter 4.5.1, Well Measurement.

A1 position: A1 center position only. See Chapter 4.5.1, Well Measurement

ZDC settings

Well bottom: Thickness and height: Thickness [um]. Set here the thickness of the plate Bottom; only
necessary for systems with ZDC.

Well bottom: Thickness and height: Distance from plate frame bottom [um]. Set here the distance from
the bottom corner of the plate to the well bottom; only necessary for systems with ZDC.

Measure. Only available when a ZDC (for hardware autofocus) is installed. The values for Thickness and
Distance from plate frame bottom can be determined by the ZDC.

Well bottom: Value variations: Thickness variation [um]. Set here a value for the thickness variation of
the plates used; only necessary for systems with ZDC.

Well bottom: Value variations: Lower surface variation [um]. Set here a value for the variation of the
distance between bottom corner of the plate and the well bottom; only necessary for systems with
ZDC.

Material: Refractive index: Set here the refractive index of the well bottom material; only necessary for
systems with ZDC.

Plate border settings

Border thickness [objective security] X/Y Border [um]. Enter a value only when the plate or slide holder
extends over the insert. Otherwise use default values.
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Autoloader settings

Hamilton method. Select a method for the Hamilton plate loading robot from the shortlist. Active only if
the robot is activated in the Devices and Ports tab of the System Configuration; see Chapter 6.1.1,
Devices and Ports.

Use barcode. Click here to use a barcode reader for the identification of the plates.

4.5.1 Well Measurement

scan”R requires information about the position of the first well (A1) of the plate in order to start the
scan. All other positions are then defined by the values given in the Plate Type Settings. Often it is
sufficient to determine the position of the well center roughly, but in some cases a more precise
measurement is necessary. The two different procedures are described in the two following chapters.

Use the measurement result always for this well plate type. Check this check box if you do not want to
repeat the A1 well measurement (see below) for each scan. The stored position will then be used each
time this plate type is selected. Once the measurement is run, a message in light green will be
displayed right of the Type box in the plate type settings window: “A1 position calibrated”.

Type |43 well test A1 position calibrated

0 For convenience it is recommended to select Types with defined first well positions (blue /
green background) whenever possible even if no autoloader robot is used. This avoids
having to set the scan starting position before each scan.

4.5.1.1 Well measurement: A1 center position only

A1 center position only. Choose this option if, for this experiment and plate type it is sufficient to
roughly set just the center position of the first well (e.g. if only central positions of each well are to be
measured).

Measure. Click here to open the Plate Measurement (for manual plate loading) window and proceed as
follows.

. %% A1 position (for manual plate loading) |§\
& . . . . é:ﬁg\l:elgfv;ﬁ% and center it
3, Confirm as scan skarting position with 0K,
‘9 000
‘00

1. Click Live view to open a live image window.
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2. Move the center of the first well into position.

3. Confirm by clicking OK.

The Plate Measurement (for autoloader robot) window will open. Click Cancel if no autoloader robot is
used. The second measurement is not required in this case.

An autoloader robot loads the plates by turning them by 180°. This has to be accounted for in the
measurement. Proceed as follows if an autoloader robot is to be used.

%% A1 position (for autoloader robot) %]

. . . . 4 1. Mount the plate turned by 1802,

2, Click Live view.
3. Move to well @ and certer it.

. . . . g + Confirm as scan starting position with DK,
Click Cancel if no autoloader is used,
9000

1. Mount the plate turned by 180° as depicted in the scheme.

2. Click Live view to open a live image window.

3. Move the center of the first well into position.

4. Confirm by clicking OK.

4.5.1.2 Well measurement: 2/3-point A1 measurement

2/3-point A1 measurement. Choose this option if the experiment and the plate type require a precise
determination of the first well position (e.g. when using full-in to measure all positions of one well).
Depending on the well shape (rectangular/circular) two or three points have to be set. In case of a
rectangular well shape, the two opposite corners of the well have to be set. In case of a circular well,
three points on the border of the well have to be determined.

Measure (in case of 2/3-point A1 measurement). Click here to open the Measure Well window and
proceed as follows.

In case of circular wells:

1. Move the border of the first well to the red cross (center) in the live image window.

2. Click Add Position.

3. Repeat this for one/two more well border positions.

4. After the second/third position has been added, the numbers field next to the Add Position
button turns red to indicate that the measurement is completed. Confirm by clicking OK.
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The three positions are used to determine the Well diameter (that will be set automatically in the Plate
Type Settings window) and the center position of well A1.

The following dialog window will open.

OK. Click here to repeat the measurement with the plate rotated by 180°. This is required if an
autoloader robot is used.

ki X
If an autoloader robot is used, the
measurement has to be repeated with the
plate turmed by 180°,

Press Ok ta continue.
If no autoloader robat is used, click Cancel.

[ Cancel | [ Ok ]

Cancel. Click here if no autoloader robot is to be used.
In case of rectangular wells:

1. Move a corner of the first well (A1) to the red cross.

2. Click Add Position.

3. Repeat this for the opposite corner of the well (the numbers field next to the Add Position
button turns red to indicate that the measurement is completed).

4. Confirm by clicking OK.

The two positions are used to determine the well height, well width and the center position of well A1.
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5 Running a Scan

This chapter explains the steps that are necessary once a scan is started and the actions and online
observations possible in the course of an experiment.

5.1 Systems with Hardware AULOfOCUS .......coecueiieiiiiiiiniiieee e 44
5.1.1 Plates with Predefined Starting POSItiON ........c..coecciiiiieeiiiccccireeee e 44
5.1.2 Slides without Predefined Starting POSItION .........ccceeieeeiiiiiiiieeeeee s 44
5.2 Systems without Hardware AULOfOCUS .........eeeeeeiiiiiiiieiieeee e 46
5.2.1 Plates with Predefined Starting POSItION .......cc.oooviciiiieeiiiinciieeee s 46
5.3 Autofocus Adjustment during @ SCan ........cccueeeeeeeieecciiiieee e eeecereee e e 47
5.4 Online IMage BrOWSING ....cceeeiiieiieeeieeeeeeeeeeeeee e e e e e e e e s e e ssnereeee e s e s ennees 47

5.5  ONINE ANAIYSIS ceeeiiiiiiieeeee ettt e e 48
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For scan”R to perform a proper scan, it is required that all Autofocus, Acquisition and Plate Manager
settings in the Edit Scan window are properly set; see Chapter 4, Setting up a Scan.

After starting the scan by clicking Run, there are different scenarios depending on
¢ the availability of a ZDC hardware autofocus

¢ the usage of plates with or without predefined starting position

These different scenarios are explained in the following chapters.

5.1 Systems with Hardware Autofocus
5.1.1 Plates with Predefined Starting Position

This is the simplest scenario: a system with ZDC hardware autofocus and a plate type with predefined
starting position, i.e., either system standard or calibrated plate types.

Upon a click on the Scan: Start button scan”R conducts the entire scan automatically as set up in Edit
Scan and stores the focused images in the predefined folder.

5.1.2 Slides without Predefined Starting Position

In case of commercial plates of one and the same type, one can in most cases assume that upon
mounting on the stage the position of well A1 will always be at the same position, and the following
scenario will not apply.

In case of spotted slides and non-calibrated plates, however, scan”R needs to be taught the starting
position each time anew.

1. Click Scan: Start to start the scanning routine. The following message will appear:

%% A1 position E|

1 2 3 4
& . . . . well A1 position has not been set.
‘9000
‘9 ® 00

[ Set ] [Useureviuus] [ Cancel l

Use previous. This option is only useful if a scan is to be repeated with the same slide immediately.
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Mo starting position for the scan has been set,
1. Move ko the center of the first (upper left) well. 4, Repeat these steps for each slide —if more than one plate is mounted —
2, Forus the speciman, after setting the next slids position,
3. Click, Select to set the skarting position. 5. Click, QK ko confirm.
o o
zF i
o @ ocus | XY navigation I
3000 :
e Coarse Fine
i Sepse
300 [um]
2500
E < 5259.57 | [um]
o
5 s s Update
0% clipping
Clipping
0% N
starting position for
Ocular view 1572x512 14228 (549,1) oF

2. Click Set to open the Scan Starting Position live image window.

3. Move to the center of the first (upper left) well.

4. Focus the specimen using the Z-drive tools.

5. Click Select to set the starting position for slide 1.

6. Repeat these steps for each plate — if more than one plate is mounted. Make sure to set the
correct slide number each time.

7. Click OK to confirm.

8. scan”R conducts the entire scan automatically as set up in Edit Scan and stores the focused
images in the predefined folder.

@ Note that the positions you define refer to the center of well A1 of the well pattern and thus
not necessarily to the first well activated for acquisition in the Edit Scan » Well Manager
window!
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5.2 Systems without Hardware Autofocus
5.2.1 Plates with Predefined Starting Position

1. Click Scan: Start to start the scanning routine. The following message will appear:

vou have to set aninitial 2 / focus position

|§Teachnew§| [Useprevinusl [ Cancel l

Use previous. This option is only useful if a scan is to be repeated with the same plate immediately.

2. Click Teach new to open the Autofocus Starting Position live image window.

'ﬂ: Autofocus Starting Position

The software autofocus requires a starting pasition.
1, Focus the specimen.
2. Click O o canfirm.

2 focus | ¥ navigation I

Coarse Fine.

Step size
300 | [um]
T —

= . | 5222.03 | [Wm]
o
3 a0 4T Update
Clipping
Histogram v
Ocular view J672x512 1250 (505,3) x|
s OK Cancel

3. Focus the specimen using the Z-drive tools.

4. Click Select to set the starting Z-position for the autofocus.

5. Click OK to confirm.
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5.3 Autofocus Adjustment during a Scan

Click the Autofocus Settings button on the main window in order to optimize the software autofocus
during a scan. The Autofocus Settings window opens. The upper box affects only the settings of the
object-based autofocus. The options of coarse and fine autofocus can be tuned and the exposure time
of the autofocus channel can be changed.

1% Autofocus Settings g |§”X|

Objects Mirimum cell Size M asimum cell Size Mark center
Frame object
Threshold XTI B0 % |[pixelz] RO00 3 |[pixelz) ™ l
[ Ignore border objects
Coarse autofocus Fine autafocus
10 % | Lavers 13 % | Layers
11.25 % | Step width [pm] 2,81 % Step width [pm]
100- 55.20 20— 15
a0 15-
&0 = :
H 10=
40— -
202 52
—lte D-; Current position — 0= Coarse focus position
-20- -
: 5
-40 - E
60- 02
U B Cameta
-30= -15-
: = Exposure kime [ms]
-100-5 =g.20 s -15 80 =

[ Apply ] [ [0]'4 ] [ Cancel ]

The controls are explained in detail in Chapter 4.1, Autofocus Settings.

5.4 Online Image Browsing

Click the Online Observation: Images: Browse button to browse through stored images of the current
scan. The Image Browser window opens.

Use the Previous and Next buttons to navigate through the images.

Delete associated images. Removes associated images, e.g. the images of one color channel.
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%# Imaga Browser gl
U e e .
(C3--W00019--PO000Z--Z00000--TO00D0-TR. b

Previous Next

Delete associated
images
Refresh
directory lisking

| Generate s |

11344x1024 0.5 16-bit image 608 (0,0) 1 2 | % intensity dlipping

Path t experiment description

D Testhesperiment._descriptar. |

Status

o

Refresh directory listing.
Well/ Position / Color/ Z/ Time. Use these buttons to navigate through the images.
Generate AVI. Set a file to export an .avi file for time-lapse experiments.

Path to experiment description. Set the path to the experiment descriptor file to load other data that
were previously acquired.

5.5 Online Analysis

After starting the acquisition it is possible to directly start the analysis of the experiment. To do so, start
the analysis software and load the experiment_descriptor.dat file by executing Scan » Open... Set up a
new analysis or load an existing analysis as described in the scan”R Analysis Software handbook.

After the acquisition and analysis are completed, it is possible to revisit the objects that were detected
during analysis. Therefore go to Repositioning » Interactive in the analysis software.

The Interactive Repositioning window opens. Select an object in the scan”R analysis software, i.e. click
either on one of the data points or on a detected object in one of the image displays (main image panel,
galleries). After selecting an object the stage moves back to the position and shows a live view.
Thereby the object selected in the scan”R analysis software is centered.
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T Intaractive Repositioning,

1.00
Step sie

Planze selact Cbjact

(& ]

205t 000

T Intaractive Repositioning,

OSATT (I MEEM) Z0dFset 1,00

Select the color channel to be displayed in from the short list. The sample can be focused with the Z-
control in case a Z-drift occurred in between the first measurement and the repositioning. The Ocular
view allows to inspect the ‘hits’ detected by the analysis by eye.

In the case that the scan”R analysis software is running on a different computer than the acquisition
software, it is necessary to set the IP address (Allowed hosts) and the port (use default 2055) of the
computer, where the analysis is running (see Chapter 6.1.4, Error Reporting/Remote). In the scan”R
analysis software open Settings and in the Repositioning & Reclassification box enter the Port of the
Acquisition Server (2055) as well as its IP Address (see also scan”R analysis Instructions, Chapter 2.3,
General Settings).
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6 System Configuration

Chapter 6 — System Configuration

This chapter explains how the system devices have to be configured in order for scan”R to work

properly.

6.1 System Configuration........ccccceeeeeeiuvveeennn.
6.1.1 Devices and POrts.......cccocceeeeeiieeerennnen.
6.1.2  MIiCrOSCOPE...oeiiuereeeeeree e
6.1.3 MT20/LED oo
6.1.4 Error Reporting / Remote.........ccccuveeeen.
6.2 Stage Calibration.........ccccccveeeerieicccneenenn.
6.2.1 Well Plate TYpes ......ccccevreverereiereeeeeeen.
6.2.2 Stage Calibration Procedure..................

6.3  Objective Parfocality .......cccceeeriereurnneeennn.
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6.1 System Configuration

Upon installation of the scan”R screening station all hardware components have to be configured for
the system to work properly. The configuration has to be adjusted if changes are made, for example, if
new filters are added of if an autoloader robot is to be integrated.

The execution of the System configuration command is password protected.

The System » System Configuration command gives access to the Hardware configuration window
with different tabs (see following chapters):

o Devices and ports to select the available hardware components and configure the PC ports

¢ Microscope to select objectives, filters and contrast inserts

e MT20 to select the excitation filters of the fluorescence illumination system

e Error reporting

¢ Remote

The System » Stage Calibration command allows an absolute calibration of the stage with hard-coded

well plate types. This is not to be confused with the stage initialization that is being carried out each
time the software is started (see Chapter 6.2, Stage Calibration).

6.1.1 Devices and Ports

% System Configuration E]

Devices and ports | Micrnscope | MT20 j LED | Error reporting | Remoke

LB ComMi -

Stage type RTC: Serial

Autoloader )
Barcode reader F COM1
Transmission shukker
Z-drift control ZDC ||

Fast turret T2 _FREACH
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UCB. Select the serial port (RS232) of the imaging PC that is connected with the RS100's universal
control box (UCB).

Stage Type: Speed. Click here to open the Stage speed window if you do not want to use the default
settings for stage speed and acceleration. Change the Velocity and the Acceleration using the
respective sliders — both for movements during a scan (System Control) and for movements under
Joystick control.

% Stage spead E]

System contral Joystick control

Welocity [%] 25 {mm|s) Yelocity [%] 10.5 {mmy's)

y

o 100 1} 100

Acceleration [%] | 100 (mm/s2) acceleration [%:] |41 (mmfs™2)

J

o 100 1} 100

[ sirf acceleration

Apply l [ K ] [Cancel]

Autoloader. Check the box if an autoloader robot is connected.

@ Note that the autoloader robot controller has to be connected to COM1.

Barcode reader. Check the box if a barcode reader is connected and select the respective serial port
(RS232) of the imaging PC.

Z-drift control ZDC. Check this box if a ZDC hardware autofocus device is connected.

Fast turret IX2_FRFACA. If a fast filter turret is available, this is automatically checked.

6.1.2 Microscope

Objectives. Select an objective type from the shortlist for each occupied nosepiece position.
Filter cubes. Set a filter cube name for each occupied position in filter cube turret.
Contrast insert. Set a name for each transmission condenser insert.

Emission filter FFWO. Set a filter name for each occupied position in the emission filter wheel.

6.1.3 MT20/LED

LED controller. This option is grayed out and out of function in scan”R.

MT20 available. Check this box if a MT20 lllumination System is available.
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% System Configuration El % System Configuration E|
Devices and ports | Microscope | MT20/LED || Error reporting | Remate Devices and ports || Microscope | MT20/LED | Error reporting | Remate
Chijectives LED cantroler ComM1
Filter cubes
UPLSAFO 10x
1 DRIl TR,
UAPO 20w [ 340 (& 2 [ CFPVFP MT20 available
LUCPLFLI Z0x R 3 |empty
UPLSAPO 20x o 4 |empty Switch of F burner after acquisition 7 O
LUCPLELR 40x R 5 |emply
|6 | UPLFLN 60 v & empty
Excitation filter
1 DAPT 350/50
2 FITC 492/18
3 TxRed 572/23
; ; 4
Emission Filter FFWO Contrast inserts =
1 Fileer 1 1 empty 5
2 Filter 2 2 emphy 7
3 3 empty & empty
4 4 empty
5 5 empty
& & emply
7
g

Switch off burner after acquisition. Check this box to cause the arc burner to be switched off
automatically after the scan is completed.

o This is a useful option for weekend or overnight operation because it saves burner lifetime.
Mind, however, that the burner needs about 10 min on restart to reach full and stable
intensity. Also, switching the burner on and off frequently reduces the lifetime. It is not

recommended to activate this switch if expected idle time of the system is less than an
hour.

Excitation filter. Set a filter name for each occupied position in the MT20 filter wheel.

6.1.4 Error Reporting / Remote

Error reporting

Error reporting. Check this box if you want error messages that may be generated during a scan to be
sent automatically as emails.

Email address and SMTP. Make sure to set the correct addresses here.

Subject and Body. You may enter default content here to be sent in addition to the error message.

Remote

The information here is only needed to allow communication between the scan”R analysis software
and the system from a remote PC.

Make sure that remote access is enabled in the corresponding MS Windows settings.
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% System Configuration El % System Configuration E|

Devices and parts || Microscope | MT20f LED | Errarreporting | Remate Devices and porks || Microscope | MT20 fLED | Error reporting | Remote

Error reparting

Email address Port

wouradress@domain. org 2085

Allowed hosts
10,2.11.178, localhost

Subject

Subject af mail

Body

Wite your own message down
here.

SMTP server
10.2.11.62

Port and Allowed hosts. Make sure to set the correct addresses here to allow remote access to the
system.

6.2 Stage Calibration

When the scan”R Acquisition software is started the stage initializes automatically to determine its
maximum limits of movements.

It is very useful — albeit not absolutely necessary — to additionally calibrate the stage, better said to
calibrate the position of the well plates relative to the absolute stage coordinate system. This is not a
procedure that has to be undertaken routinely, it suffices to do it once upon installation of the system.
Thus, the access to this routine is password protected.

6.2.1 Well Plate Types

There are three different classes of well plate types:

a) System standard well plates. These are certain commercial plates with hard-coded dimensions using
the specifications of the manufacturers. Their parameters are not editable in the Plate Manager: Edit
plate types. (See Chapter 4.4, Plate Manager.) Only such plates can be used for the stage calibration.
Once the stage is calibrated the A1 position of these plates is always determined after stage
initialization upon software start — and thus does not have to be determined prior to the start of a scan.
Standard well plates are highlighted blue in the Plate Manager.
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Plate Type

Twpe |12 Well (MUMC 150623) System calibrated format. Press "new” to modify the Format.

b) Calibrated well plates. This can be any type of well plate in principle. Once such a plate type is
calibrated via the Edit Plate Types and the Position A1 measurement the A1 position of such a plate is
always determined after stage initialization upon software start — and thus does not have to be
determined prior to the start of a scan.

Calibrated well plates are highlighted green in the Plate Manager.

Plate Type

Type |45 Well test | Al position calbrated

c) Non-calibrated well plates. Before the start of a scan the user is asked to move the stage to the A1
position.
Non-calibrated well plates are not highlighted in the Plate Manager.

Plate Type
test_p | | 96 el v | | Edi plate types
Tvpe | 12 well | A1 position uncalibrated

6.2.2 Stage Calibration Procedure

k' Corner, selection for calibration

% Please choose Plate for System Ca... g|

Flease select the stage frame corner which will be calibrated:

left right 4
Corner hor, position
el s vee K
£ w
At
Corner vert, position
Up -
I
[ oK ] [ Cancel ] *
The calibrated corner is at the
opposite side of the hook.

1. Place a system standard well plate on the stage and select the well plate type in the Plate
Format window.
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2. Execute System » Stage Calibration.

3. Perform the 3-point A1 Measurement as described in Chapter 4.5.1.

Once the procedure is completed the stage is calibrated and the A1 position of system standard as
well as calibrated well plates will always be located at a known position.

6.3 Objective Parfocality

This command allows you to set an offset for the Z-position for the used objectives, so that when
changing the objective, the focus is maintained.

1. Execute System » Objective Parfocality.

2. Select the first objective to be used from the Objective short list (e.g. UPLSAPO 20x). (It is
convenient to start with the objective which has the highest magnification).

3. Set the focus by using the Z-focus wheel on the microscope and pressing Update when the
sample is focused or by using the Z-focus arrows/slider.

4. Make sure that the Parfocality value for the first objective is set to 0.

¥ Parfocality satup =

Exchston fite

| Foous | Ocudr view Ji3H1024 050560 (1314,262) x| [[Conent

5. Select the next objective from the Objective short list (e.g. UPLSAPO 10x). At first the image
will be blurred.

6. Set the focus for the second objective by using the up and down arrows in the Parfocality
field.
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¥ Parfocality satup E

Cartera

- Thos | it ravigation |
Expusure Lime (1]
o 192 & [awoset
Coorsn Fra Loeled
| ir] T e Camera Birning
:I 3. fiam] 1 &
m =
hid Current poskon
1 5319.08 | [1m]
1 Mesncopn
= [uedae | *
Fiter cube
Clepry DAFTR ~
Hstogram
Objective
LSAPO I0x W
Parfocaity [jan]

fec "
= = Exotiston fiter
FITEC 492010 -
[ Trarmimsson
Intengky: I
1% 100%

| Foous | Ocular view J 31024 0.5¢ 407 (1206,6%)

7. Repeat steps 5 and 6 for all other objectives for which parfocality is to be set.

The focus position will now be maintained when changing the objectives.
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7 Appendix

The following chapter provides additional technical information.

7.1 Data Storage Format.........ccceeeeeeeiieieieieeeeeeeeen,
7.2 EIror MESSAgES...ccoeeeeeeeeeeeeeeeeeeeeeeeee e
RS T - Tox (] YA o To | R
7.3.1  LidPIiCKUP.EXE .. .eeeieiieeee e
7.3.2  LiMIitSEtUP.EXE ceeviiieeieeeieee e
7.4  Remote CONrol......ccoviieier e
7.4.1 Connection to the server......c.cccoceveeiceenenneen.
7.4.2 Communication interface concept..................
7.4.3  COMMANGS...oiiiiiieiiireee e

Chapter 7 — Appendix

7.4.4 Known use cases and corresponding communication samples................ 70
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7.1 Data Storage Format

All the data for a specific scan is stored in the respective storage directory defined on the Acquisition
tab of the Edit scan window. The storage scheme is as follows:
Screen01

Experiment_descriptor.dat

Experiment_descriptorxml

Data
— B1--W00007--PO0001--Z00000--T00000--alexa. tif

— B1--W00007--PO000T--Z00O00--T00000--dapi.fif
B1--W00007--POO002--Z00000--T00000--alexa. tif

Screen01: storage directory; Experiment_descriptor.dat: position file; Experiment_descriptor.xml: scan settings file.
The system parameters are stored in the .xml file, the stage positions in the .dat file.

A Data subdirectory contains the actual image files in .tif format. Individual fields separated by a double
dash compose the image file names. These fields denote in the order of appearance the well comment
as shown in the table of the format manager, the well index, the position index, the Z-stack index, the
time loop index, and the channel name.

The names are assembled systematically as a systematic train of parameters separated by double
dashes in the following order: well name (Comment), well index, position index, Z-layer index, time loop
index and the channel name.

7.2 Error Messages

Devices initialization

Error Message Explanation / Possible Measures

No connection to controller - Retry (timeout | ® There is a communication problem with the real-time controller. Make
70s) — Cancel sure that it is installed and configured properly with ObsConfig.exe
and ObsUpdate.exe located in scan”R acquisition directory.

And then:

Connection to real-time controller RTC failed.

Camera not responding. Please check your e There is a communication problem with the CCD camera. Make sure
installation and cable connections. that it is installed properly and appears in the hardware control panel
of the computer.

e Check your cable connections.

Stage not responding. Please check your e Check if the stage controller is connected to the serial port of the PC
cable connections and your serial settings as configured in Settings » System configuration.

e Make sure that the controller is turned on.
e Check if the PC serial ports are set correctly in Settings » System

configuration. scan”R uses the following values: Bits/second: 19200,
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Data bits: 8, Parity: N, Stop bits: 1, Flow control: NONE

For detailed instructions on how to set the appropriate parameters
please refer to the hardware manual.

UCB not responding. Please check your
cable connection and your serial settings.

Check that you have connected the microscope controller (UCB) to
the serial port of your computer as configured in Settings » System
configuration.

Make sure that the UCB is turned on

Check if the PC serial ports are set correctly in Settings » System
configuration. scan”R uses the following values: Bits/second: 19200 ,
Data bits: 8, Parity: E, Stop bits: 2, Flow control: NONE

For detailed instructions on how to set the appropriate parameters
please refer to the hardware manual.

UCB Could not move objective to lower
position, before stage calibration.

Please reset the UCB and process to system
initialization again.

Move the objective manually from the lowest position

Reset the UCB and process to system initialization again.

HW AF ZDC activated, but HW AW or IX2 not
found.

Please deactivate in Settings!

No Hardware autofocus was found on the system. After the devices
initialization, deactivate the checkbox “ZDC present” in System »
system configuration

Factory Setup File. Not found. Leaving
Program.

The config file “FactorySettings.xml” was not found. The software
cannot start.

Proceed to installation of the Scan”R setup.

No configuration file found. Please configure
your system.

No default settings for a scan were found.

Configure or Proceed to installation of the Scan”R setup.

Start of screen

Error Message

Explanation / Possible Measures

Robot instruction found but robot not
configured properly.

A position file with autoloader robot instructions is found but the
robot operation has not been configured in the New / Edit Scan
window of Edit Scan » Format » Format Manager your configuration.
Enable robot operation in Settings » System configuration.

Please select a proper destination directory
in your settings. Scan aborted!

You selected a custom position file in your Plate Manager settings.
This file does not exist.

The selected storage directory does not exist.
You have not selected any destination directory.

An error occurred during robot operation.
Please open the case and move the robot to
the initialization position.

The movement of the robot was interrupted. This occurs when there
is an obstacle in the movement path of the robot. Make sure that the
robot can move freely. Turn off the robot controller and move the
robot to the initial position.

Please remove your plates from the
microscope and empty the stack. Scan
aborted.

An error occurred during the initial steps of a scan. The robot
detected a plate on the stage or on any stack assumed empty.
Remove the plate.

If the robot is configured, not more than one
plate starting position is possible.

You tried to configure more than one plate on a single sample holder
combined with automatic robot loading. The selection of more than
one plate on a single holder at the same time is only supported if
manual loading is chosen.

You have not taught any position. No Scan
will be started.

You have not taught a starting position for the scan. Please choose
yes if you are asked to teach a starting position (after starting a scan).
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No stage pick-up position has been defined
for the robot. To define it, please exit the
software and use the tool
"./FactorySettings/LidPickup.exe".

Scan cannot be started.

e A scan is configured with an autoloader, but the stage pick-up
position for the robot was not yet defined

o Define the pick-up position with the utility LidPickup.exe

Not enough space left to fulfill your request.
For robot loading a number of 20 plates is
assumed. The remaining space is sufficient
for ... complete plates / repetitions.

e The hard disk space left will be not large enough for the scan.

e Free hard disk space or change the configuration of the scan.

Warning: images of one or many
subposition(s) will not be taken because they
are outside the XY limits for the selected
objective.

e At the start of the screen it is checked if all subpositions will be inside
the limits when XYZ limits are activated.

e Check if the plate is right calibrated in Edit » Plate manager
e Check if the subposition pattern is inside the well

e Check the XY limits for the screening objective in Devices » XY
navigation (limits are drawn as white lines)

Image browser

Error Message

Explanation / Possible Measures

An error occurred during deletion. Please
check that you have the right permissions
and no other program locks the data.

e This error message may appear when you delete files while an
analysis routine is running. Make sure that no external program (such
as an image file viewer) has opened any of the files to be selected.

Loading a scan

Error Message

Explanation / Possible Measures

File not found

e Choose an existing file

You are trying to load a new XML file with an
older software version:... Please update

e Update the software to load the scan settings

Error occurred while loading scan settings

e The file was not a correct settings file

Miscellaneous

Error Message

Explanation / Possible Measures

dcam_wait

e Atimeout occurred during camera operation, that is, an image could
not be taken in time during the scan.

e Make sure that no other software blocks such a big part of the
system resources that the image acquisition is disturbed. For further
operation, restart scan”R.

e Check that the camera trigger cable is connected properly. For
further operation, restart scan”R.

Stage: Position not reached within time limit.
Please check your connections and settings.

e This error may occur during the stage calibration. Repeat the
calibration in the following manner:

Exit scan”R
Reset the stage controller by switching the power off and then on again.

Move the stage with the joystick so that the stage insert is centered
above the objective.

Restart scan”R.

Error —xxxxxxxx occurred at VISA ........

e This may be serial communication problem. Refer to the following
error messages:
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e Stage not responding ...
e UCB not responding ...

o If the problem still exists after taking the measures described there,
contact your Olympus representative with a detailed description of
the error message.

You entered at least one illegal character. The | ¢ A file name input contained one of the listed characters. File names
characters/ \ :*? " <> | are not allowed. may not contain any of these.

Cannot use the selected objective at this e XYZ limits are activated and the objective is not in an allowed position
position. Please move the stage to a secure
XY position. Please move the objective to a
Z value inferior to ... pm

o Move the stage so that the objective appears in the center of the
frame

e Move the objective to a lower position if recommended.

7.3 Factory Tools

The programs described here are stored in the scan”R program folder in \Aquisition\FactoryTools.

7.3.1 LidPickup.exe

Pick-up position

The Pickup position is used when performing a scan with an autoloader. This is the position at which
the stage will move when the autoloader adds or removes the plate.

Follow these steps to set-up the pick-up position:

1. Move the stage to the desired pick-up position

2. Press Set as Pickup

Pipetting position
The pipetting position is only used by the liquid handling interface, (see Chapter 7.4, Remote Control
Follow these steps to set up the pipetting position:

1. Move the objective to the center of a well and press Set well center.

2. Move the same well under the pipetting machine and press Set Pipetting position.

When the offsets are many centimeters large, it will not be possible to move every well under the
pipetting machine.
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%% Lid Pickup Position Setup

Pickup position

Please check Stage/Lid collision whenever moving Stage.

Adjust stage pickup position and press "Set as Pickup”

ATTENTION: FACTORY CALIBRATION TOOL

Inproper use might damage the System,
Jovystick required for setup,

Skage ¥ [pm]
50,0

Skage ¥ [pm]
50,0

Pickup Position:

Get Position
Set as Pickup

# [pm] W [prn]
1s6zs,0 2| |73865,0

~
-

Pipetting position

Move the objective to the center of a well and press "Set wel center”

Move this center of well under the pipetting machine and press "Set Ripetting Position”

Set well center l

[Set Pipetting Position |

Pipetting offset:

% offset [um]
0,0 ~ |o,0

' affset [m]

~
-

OF.

l [ Cancel ]

7.3.2 LimitSetup.exe

OLYMPUS

The options described in this chapter are only available with a motorized stage controlled by a STC

controller.

With this program it is possible to define separate XYZ limits for each objective.

To activate or deactivate the limits in the Scan”R acquisition program, check or uncheck the box
Activate the limits in Scan”R acquisition.

If the stage is not calibrated, run a stage calibration using scan”R acquisition.exe (see Chapter 6,

System Configuration)

The defaults might be used depending on the accuracy required.
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Start the Program: .\Acquisition\FactoryTools\LimitSetup.exe and follow the steps as indicated on the
dialog.

% Factory Limit Setup Utility

ATTENTION: FACTORY CALIBRATION TOOL [l activate limics in Scan"R acauisition

Inproper use might damage the System.
Joystick required for setup,

Flease check for ObjectivefStage colision and StagefLid collision whenewer
moving Stage or Ohjective.

1. Check the given frame lenghts.

Stroke_
Frame - -
Stroke_x [um]  Stroke ¥ [um]
124000 86000 o
—bl —
Border_¥ [pm]  Border_¥ [pm]  Border_Z [um]
2000 1) 900
Corner
- - {calibrated in Scan~R. acquisition)
Border_X
2. Select the ohjective for which you want to define XYZ limits
X Distance from Frame:
Revolver Pos.  Objective D[um]  D¥[um]  R[um]: Max(D¥,DY) DZ [um]
<E5E3 v empty [ [1} 1] 0 0
3. Move to a frame corner, set XYZ maximum, and press "Calculate R, D"
Fine z )
2 Step size [um]  Current z position
E 50 i [um]
[ Calculate R, DZ ] [Set Defaults
4. Test if the limits are OK.
Calculated XYZ Limits Mazimum X¥Z Hardware Limits
Calculate and set Limits rviny (] ymin [um] scmin [pm] wmnin [Lam]
a a a 0
wrnax [pm] e [pm] zmax [pm] xmax [pm] ymax [um] zmax [um]
1) 1) 1) a o a

Position

¥ [urn] f [um] Z [m]
0 0 i

5, If the limits are OK, press save

Save

6. Go to point 2 for another ohjective

1. Check the given frame lengths: When the dialog appears the first time it will show the
defaults values for Stroke and Border. Check if these defaults are the correct ones when you
compare them with the construction drawings of the used frame in Scan/R. If you have more
precise values in your drawing correct these values.

2. Select the objective for which you want to define the XYZ limits. Start with one objective for
which you want to define XYZ limits. To do that select the revolver position where the
objective is installed and select the corresponding objective from the list. You may
physically unscrew the objective and exchange it by another one if required. This step will
define the objective for which the limits are set.

3. Move to a frame corner ...This is the adjustment step for the objective. You can modify Z
with the cursors and XY with the joystick to adjust the limit position for the objective. For
control reasons the distances DX, DY are also displayed and for safety MAX(DX,DY) is taken
as Objective Radius for the limit setup.
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4. Test ...This allows checking if the limits are OK. To do this, press the button Test Limits. The
hardware limits will then be applied. You can now carefully move with the joystick to check if
the objective stops at the required positions.

5. Click Save if the limits are OK. This will store the frame settings and the values R,dZ for the
specified objective in the objective list \Acquisition\config\ObjectiveSettings.xml).

6. Continue at point 2 for the next objective

If an additional limit is required because of a frame or plate inserted this can be modified in the Border
Thickness Fields of the Plate format (see Edit Scan » Plate manager » Edit Plate Types; Chapter 4.5,
Plate Type Settings).

Frame Border x

Stroke x

Stroke y
Stage Calibration Corner x,y,z

\ 4

[}
[}
|
FocalPRlane - __________ S S NN L ———

|
7N

Frame Border z

Representation of the frame and objective. When setting up the limits, the objective parameters r and dZ are evaluated and
stored.
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7.4 Remote control

The program ‘Remote control.exe’ can be found in the scan”R program folder in \Aquisition\Remote
control. The program allows to synchronize an external hardware device (e.g. a liquid handling system)
with the scan”R Acquisition.

7.4.1 Connection to the server

The acquisition software is the server. The client connects to the server with the TCP/IP protocol on the
port defined in System » System configuration » Remote

Only one client can connect to the acquisition software.

When not in standalone mode, and when the Edit Scan window is not opened, the server is waiting for
connection.

When a client connects, all buttons of the scan®R main interface are deactivated, except for the
Browse button.

7.4.2 Communication interface concept

Syntax:
Client Request: [Command_name + arguments + carriage return + linefeed]
This has to be sent within 6 seconds

Server Answer: [Command_name + arguments + (OK or ERROR or DENY) + (response or error
description) + carriage return + linefeed]

DONE. The command was successfully executed

DENY. The command cannot be executed (the syntax is not correct or the time point is not correct).
When a previous command is being executed, it continues to run. When no command was being
executed, it waits for the next command.

ERROR. An error occurred while executing the command

Error descriptions:
- Command not known

- Argument not known

67
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- Argument over range

- Screen is running

- No screen is running

- Waiting for end of previous command

- RunTo "Argument" not reached until end of experiment
- File not found

- Empty message: others errors are written in the logfile
- screen continues

- screen ended

During a screen, when an error occurred, the error descriptions “screen continues” or “screen ended”
indicate if the screen is aborted or not.

The communication is logged in the viewable logfile, with following preceding Server/Client TAG:
SERVER:
CLIENT:

7.4.3 Commands

Quit. The connection is closed by the server.
GetCominterfaceVersion. Returns the interface version number
Response:

GetCominterfaceVersion DONE 1

StartExperiment. Starts the experiment like the start button.

Responses:

StartExperiment DONE

StartExperiment DENY Screen is running

StartExperiment ERROR (cancelled by user, wrong settings for example, not enough hard disc space)

When not enough hard disc space left, screen is aborted.

StopExperiment. It stops the experiment like the stop button.
Responses:
StopExperiment DONE

StopExperiment DENY No screen is running
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SetExperimentCluster filename. Changes the current settings like the open button when no screen is
running

The experiment comes from a filename. The filename is relative to the directory: Scan Settings Library.
Examples:

CLIENT: SetExperimentCluster test.xml
SERVER: SetExperimentCluster test.xml DONE

CLIENT: SetExperimentCluster Administrator\test.xml
SERVER: SetExperimentCluster Administrator\test.xml DONE

CLIENT: SetExperimentCluster test_not_existing.xml
SERVER: SetExperimentCluster test_not_existing.xml ERROR File not found

CLIENT: SetExperimentCluster test.xml
SERVER: SetExperimentCluster test.xml DENY Screen is running

GetNumber Argument. Argument is one of the following: Wells / Subpositions / Timeframes
Examples:

CLIENT: GetNumber Subpositions
SERVER: GetNumber Subpositions DONE 4

CLIENT: GetNumber Timeloops
SERVER: GetNumber Timeloops DENY Argument not known

RunTo Argument. Argument might be one of the following:

ExperimentEnd / PlateEnd / Well_XY / Well_XYZ / Subposition_XY / Subposition_XYZ / TimeFrame
Argument: number

Examples:

CLIENT: RunTo ExperimentEnd
SERVER: RunTo ExperimentEnd DONE

CLIENT: RunTo TimeFrame 6
SERVER: RunTo TimeFrame 6 DENY Argument over range

MoveTo Argument. Argument might be one of the following:

PlatePickupPosition. Only available before screen has started. Moves to the Plate Pickup Position
(used for Robot) and returns to last position when the next command is received

PipettingPosition. Only available after screen has started. Moves the Plate by a fixed predefined XY-
offset and returns to last position when the next command is received. The Pipetting offset position is
defined in the utility ./FactorySettings/LidPickup.exe . This can be useful for transmission light imaging.

Example of responses:

MoveTo PlatePickupPosition DONE

MoveTo PlatePickupPosition DENY Screen is running
MoveTo PipettingPosition DONE

MoveTo PipettingPosition DENY No screen is running

MoveTo PipettingPosition ERROR (pipetting position cannot be reached for example)
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7.4.4 Known use cases and corresponding communication samples

All settings files can be used in normal user mode as well. Thus they can be tested and setup
independently from the server/client mode. All data resulting from a client/server mode screen is fully
compatible and analyzable with the anlysis.

A) scan”R is to be fully integrated into a plate sample preparation line

1. Test the different plates and assays in scan”R. Save the different setting files in the directory
‘Scan Settings Library’. Every kind of scan available in the user mode will also be available in
the server mode.

2. Communicate with the server according to the following workflow:

Server Client

SetExperimentCluster PrefinedExperiment1

SetExperimentCluster DONE

MoveTo PlatePickupPosition

MoveTo PlatePickupPosition DONE

StartExperiment

StartExperiment DONE

RunTo ExperimentEnd

RunTo ExperimentEnd DONE

SetExperimentCluster PrefinedExperiment2

SetExperimentCluster DONE

... and so forth

3. Analyze separately each scan in scan”R analysis. The analysis has to be run in batch mode
or in parallel. The batch has to be fed manually.

B) Well-Time-lapse acquisition using a liquid handling automate trigger substance for starting the time-
lapse (Analogous for Subpositions or Plate Time-lapse).The liquid insertion changes the AF layer
position. Therefore AF should be performed after liquid insertion.

Example:

1. In the scan”R Acquisition software execute Edit scan » Acquisition and select Loop: Well in
the Time-lapse settings box and adjust the settings.

2. Communicate with the server like the following workflow (3 wells have been selected in the
scan”R acquisition GUI)
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Server Client

GetNumber Wells

GetNumber Wells DONE 3

StartExperiment

StartExperiment DONE

RunTo Well_XY

RunTo Well_XY DONE

“The automate provides the liquid”

RunTo Well_XY

RunTo Well_XY DONE

“The automate provides the liquid”

RunTo Well_XY

RunTo Well_XY DONE

RunTo ExperimentEnd

RunTo ExperimentEnd DONE

C) Well-Time-lapse acquisition using a liquid handling automate trigger substance for starting the time-
lapse. The trigger point is time sensitive and insertion of the liquid does not change the AF plane. It is
required to make time-lapse images of the same position before and after the insertion to observe the
changes due to the insertion.

Example:

1. In the scan”R Acquisition software execute Edit scan » Acquisition and select Loop: Well in
the Time-lapse settings box and adjust the settings. Only one subposition should be
selected for the settings

2. Communicate with the server like the following workflow (2 wells have been selected in the
scan”R acquisition GUI, the number of time-lapse frame has been set to 40)

Server Client

StartExperiment

StartExperiment DONE

RunTo Well_XYZ

RunTo Well_XYZ DONE

RunToTimeFrame 20

RunToTimeFrame 20 DONE

“The automate provides the liquid”
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RunTo Well_XYZ

RunTo Well_XYZ DONE

RunToTimeFrame 20

RunToTimeFrame 20 DONE

“The automate provides the liquid”

RunTo Well_XYZ

RunTo Well_XY ERROR RunTo Well_XY not reached

until end of experiment

RunTo ExperimentEnd

RunTo ExperimentEnd DENY No screen is running

% Remote control

Cormands always available
it
GetComInterfaceversion
Gethumber Wells
Gethumber Subpositions
GetMurnber Timeframes

Commands avalable before screen
StartExperiment

| SetExperimentCiuster
MoveTo PlatePickupPosition

Commands available during screen
RunTo ExperimentEnd
RunTo PlateEnd
| RunTo wWell 0y
RunTo el XYz
| RunTo Subposition_xY
RunTo Subposition XYz
RunTo TimeFrame
MoveTo PipettingPosition
StopExperiment

Comrmand
SetExperimentCluster test2 xmi

Experiment path relative to Scan Settings Library

testZ . xml

Timeframe value
0

Done  Yalue
[* 3 0
Cery

<&

Error




scan® Acquisition Software Chapter 7 — Appendix

Not supported with the given specification are:

Multiple liquid insertions at a single Well/Position with subsequent interrupted time-lapse acquisition
AND AF after the second insertion step.

Automated Analysis takeover of time-lapse ranges (time-lapse liquid insertion points have to be
remembered and set manually in the analysis software).

Feedback loops are only possible with considerable client programming as scans have to be
stopped and newly prepared settings have to be issued.

Within a single scan no sequences are possible that are different from the regular sequences. In
order to change the sequence the scan has to be stopped and restarted.
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